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Introduction to Active Roles On
Demand

One Identity Active Roles is an access management system designed to assist
administrators in the access management of on-premises, hybrid and cloud enterprise
infrastructures, such as Microsoft Active Directory (AD), organization mailboxes,
Lightweight Directory Services (LDS), and so on. Besides providing tools to provision
access to various company resources (user accounts, computers, email addresses,
printers, and so on), it also allows you to set up business unit-level or company-level
policies and workflows for automating access management tasks to save administration
time and operational costs.

One Identity Active Roles On Demand is a complete Active Roles installation, provisioned in
the One Identity cloud and connected to your network through a virtual private network
(VPN). One Identity operates and monitors the runtime environment for you.

When purchasing and deploying Active Roles On Demand the first time, you must send a
set of network and VPN connection information to One Identity via the One Identity Starling
portal (https://www.cloud.oneidentity.com), and you must upload an offline domain join
file. The One Identity Cloud Operations Team then provisions your Active Roles On Demand
environment based on the information and offline domain join file you provided.

This provisioning can take up to 24 hours to complete, and some additional VPN
configuration may be required to adjust your VPN gateway device to connect to the VPN
gateway you hosted.

As One Identity is provisioning Active Roles On Demand in an address that is private to
your VPN, One Identity provides the IP address for Active Roles On Demand and the
administrator account credentials.
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Active Roles On Demand system
requirements

One Identity Active Roles On Demand provides its core features in a SaaS-delivered model.
Therefore, you do not need to install the Active Roles Administration Service and the Active
Roles Web Interface components on-premises.

However, to access, configure and maintain the Active Roles On Demand solution, you
must install certain client-based Active Roles components on-premises with the indicated
system requirements.

Before using the 30 May 2022 release of Active Roles On Demand, ensure that you meet
the following requirements.

Active Roles Management Tools

Active Roles Management Tools is a composite component, providing the following client-
based tools to configure and manage your Active Roles deployment:

« Active Roles Configuration Center
| NOTE: Active Roles Configuration Center is available on 64-bit systems only.
« Active Roles Management Shell
« Active Roles SDK
« ADSI Provider

Table 1: Active Roles Management Tools system requirements

CPU Intel x86, Intel 64 (EM64T) or AMD64 processor, 1 GHz or
faster.

RAM 1 GB or more.

Disk space 100 MB

Supported 0OS « Microsoft Windows Server 2022, 2019, or 2016

(Standard or Datacenter edition).

« Microsoft Windows 8.1 or 10 (Professional or Enterprise
edition, 32-bit or 64-bit).

NOTE: Active Roles is not supported on Windows Server
Core installations.

.NET Framework 4.7.2
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Windows Management 5.1
Framework

Miscellaneous o Visual C++ 2017 Redistributable

« Microsoft Windows Remote Server Administration Tools
(RSAT) for AD is required to manage Terminal Services
user properties with Active Roles Management Shell or
Active Roles Management Tools.

Configuration Center

Active Roles Configuration Center provides a single solution for configuring the Active Roles
Administration Service instances and Active Roles Web Interface sites, allowing
administrators to perform the core configuration tasks from a single location. These
include the following:

« Creating and configuring the Active Roles Administration Service and the default
cloud-based Active Roles Web Interface sites.

« Managing the core Active Roles Administration Service settings, such as the Active
Roles administrator account, service account, and database connection.

. Managing the core Active Roles Web Interface settings, such as the site address
on the web server and its configuration object in the Active Roles
Administration Service.

» Logging options for troubleshooting Active Roles components.

NOTE: Currently, when opening the Logging settings of the Active Roles Config-
uration Center, the Logging page will be blank. As a workaround, contact the One
Identity Cloud Operations Team if you need to change your logging settings.

« The Starling Join feature, enabling Active Roles to connect to the One Identity
Starling Cloud Platform and integrate with additional One Identity products for
additional functionality.

Active Roles Management Shell

A set of Management PowerShell cmdlets, providing a means for executing and automating
tasks in Active Roles and covering three key areas:

« Active Directory objects
« Active Roles configuration

« Active Roles Synchronization Service

Active Roles SDK

The Active Roles SDK, providing samples and documentation for developers to help them:
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« Customize Active Roles by creating custom client applications and user interfaces.

« Expand the use of Active Roles by integrating it with the existing proprietary
applications and network data sources.

ADSI Provider

The Active Directory Services Interface (ADSI) Provider enables custom user interfaces
and applications to access Active Directory services through Active Roles. ADSI Provider
translates client requests into DCOM calls and interacts with the Active Roles
Administration Service.

The Active Roles ADSI Provider allows custom scripts and applications (such as web-based
applications) to communicate with Active Directory, while taking full advantage of the
security, workflow integration and reporting benefits of Active Roles.

The data exposed by Active Roles ADSI Provider is organized in a namespace identical to
the namespace of the Windows system LDAP provider. The name of the Active Roles ADSI
Provider namespace is EDMS://, instead of using the Microsoft LDAP:// namespace).

Active Roles Console

Active Roles Console (also known as the MMC Interface) is a Microsoft Management
Console (MMC) snap-in for a Microsoft Windows-based user interface.

Administrator users can use Active Roles Console to perform most Active Roles
configuration actions while standard users can perform daily delegated administration and
operations with it.

Table 2: Active Roles Console system requirements

CPU Intel x86, Intel 64 (EM64T) or AMD64 processor, 1 GHz or
faster.
RAM 1 GB or more.

NOTE: The amount of memory required by Active Roles
Console depends on the total number of managed objects.

Disk space 100 MB

Supported OS « Microsoft Windows Server 2022, 2019, or 2016
(Standard or Datacenter edition).

o Microsoft Windows 8.1 or 10 (Professional or Enterprise
edition, 32-bit or 64-bit).

NOTE: Active Roles is not supported on Windows Server
Core installations.

.NET Framework 4.7.2
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Web browser Microsoft Edge 79 (or newer), based on Chromium

Miscellaneous Visual C++ 2017 Redistributable

Active Roles Web Interface Access

The Active Roles Web Interface is a browser-based administration interface for Active
Roles users and administrators. Certain Active Roles administration configuration actions
(such as Microsoft 365 integration) is only available via the Web Interface.

The Active Roles On Demand solution hosts the Web Interface in a SaaS-delivered model,
requiring no on-premises deployment. However, you need to meet the following
requirements to access the Web Interface.

Table 3: Active Roles Web Interface access requirements

Web browser o Internet Explorer 11
« Google Chrome 61 (or newer)
« Microsoft Edge 79 (or newer), based on Chromium

« Mozilla Firefox 36 (or newer)

Display resolution The Active Roles Web Interface is optimized for screen
resolutions of 1280x800 or higher.

The minimum supported screen resolution is 1024x768.

Optional Active Roles Components

Active Roles On Demand provides several optional components that you can install on-
premises for additional features. These components include:

« Active Roles Synchronization Service
« Active Roles Synchronization Service Capture Agent

« Active Roles Reporting (Data Collector and Report Pack)

Active Roles Synchronization Service

NOTE: If you plan to manage Azure AD or Office 365 operations in your environment, you
must install the Active Roles Synchronization Service component.

The Active Roles Synchronization Service lets you:
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« Synchronize identity information stored in data systems other than Active Directory
(AD) and Active Directory Lightweight Directory Services (AD LDS) supported by the

Active Roles Console.

« Automate identity information management among the various supported data
systems (for example, by using workflows to create, read, update, delete, or
deprovision identity information with Active Roles).

For more information on the Active Roles Synchronization Service, see Available Active

Roles Reports.

Table 4: Active Roles Synchronization Service system requirements

CPU

Disk space

Supported OS

Supported databases

.NET Framework

Windows Management
Framework

Miscellaneous

Supported connector
versions

(GNE IDENTITY
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Intel x86, Intel 64 (EM64T) or AMD64 processor, 1 GHz or
faster.

NOTE: One Identity recommends using a multi-core
processor for the best performance.

2 GB or more.

NOTE: The amount of memory required depends on the
number of synchronized objects.

250 MB

Microsoft Windows Server 2022, 2019, or 2016 (Standard or
Datacenter edition).

NOTE: Active Roles is not supported on Windows Server
Core installations.

« Microsoft SQL Server 2019, 2017 or 2016, any edition.

« Microsoft SQL Server 2014 or 2012, any edition, 32-bit
(x86) or 64-bit (x64), with or without any Service
Packs.

4.7.2
5.1

Visual C++ 2017 Redistributable

« Active Roles versions 7.4.3, 7.4.1, 7.3, 7.2, 7.1, 7.0,
and 6.9.

« Data sources accessible through an OLE DB provider.
. Delimited text files.

« Generic LDAP Connector.

. IBM AS/400 Connector.

. IBM Db2 Connector.

« IBM RACF Connector.
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Micro Focus NetIQ Directory.

Microsoft AD Domain Services with the domain or forest
functional level of Windows Server 2012 (or higher).

Microsoft AD LDS running on any Windows Server
operating system supported by Microsoft.

Microsoft Exchange Server version 2019, 2016, 2013, or
2010.

NOTE: Microsoft Exchange 2013 CU11 is not supported.
For more information, see Knowledge Base Article
202695 on the One Identity Support Portal.

Microsoft Lync Server version 2013 (with limited
support).

Microsoft Skype for Business 2019, 2016 or 2015

Microsoft Windows Azure AD (using the Azure AD Graph
API version 1.6).

Microsoft Office 365 directory.

Microsoft Exchange Online service.
Microsoft Skype for Business Online service.
Microsoft SharePoint Online service.

Microsoft SQL Server (any version supported by
Microsoft).

Microsoft SharePoint 2019, 2016, or 2013.
MySQL Connector.

One Identity Manager version 7.0 (D1IM 7.0).
One Identity Manager version 8.0.

Oracle Database.

Oracle Database User Accounts.

Oracle Unified Directory.

OpenLDAP Connector.

Salesforce Connector.

ServiceNow Connector.

NOTE: Data sources accessible through an OLE DB provider,
delimited text files, and IBM RACF data systems are
supported by Active Roles Synchronization Service without
bi-directional support.
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Active Roles Synchronization Service
Capture Agent

Active Roles Synchronization Service provides a Capture Agent to synchronize user
passwords between Active Directory (AD) domains managed by the Synchronization
Service and other connected data systems.

NOTE: To synchronize passwords from an AD domain to other connected data systems,
you must install the Synchronization Service Capture Agent on all domain controllers in
the source AD domain.

Table 5: Active Roles Synchronization Service system requirements
.NET Framework 4.7.2

Supported OS on domain Microsoft Windows Server 2022, 2019, or 2016 (Standard or
controllers Datacenter edition).

Both x86 and x64 platforms are supported, with or without
any Service Packs.

Active Roles Reporting

Active Roles offers optional on-premises reporting capabilities with its Data Collector and
Report Pack, allowing you to view Active Roles tracking logs for administrative roles,
Managed Units (MUs), policy compliance, Policy Objects, and the state of key Active
Directory (AD) objects.

Active Roles Data Collector and Report Pack facilitates the collection of environment data
(stored in an SQL Server database) and the automated generation of reports on
management activities. The Report Pack component is deployed on Microsoft SQL Server
Reporting Services (SSRS) to view, save, print, publish, and schedule Active Roles reports.
For more information on the available report, see Available Active Roles Reports.

Table 6: Active Roles Collector and Report Pack system requirements
.NET Framework 4.7.2

Supported OS on domain Microsoft Windows Server 2022, 2019, or 2016 (Standard or
controllers Datacenter edition).

NOTE: Active Roles is not supported on Windows Server
Core installations.

Supported databases « Microsoft SQL Server 2019, 2017 or 2016, any edition.

« Microsoft SQL Server 2014 or 2012, any edition, 32-bit
(x86) or 64-bit (x64), with or without any Service
Packs.
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.NET Framework 4.7.2

Other Active Roles The Active Roles Management Tools must be installed and

components must have the same version as the Active Roles
Administration Service, due to using the Active Roles ADSI
Provider component.

Available Active Roles Reports

Active Roles provides reporting services for the following Active Directory and Active Roles
objects, components and events.

Active Directory Assessment

« Domains
« Domain account SID resolution.
o« Domain Summary.
o Domain Trusts.
o Group Membership
o Group Membership by groups.
o Group Membership by users.
o Users with domain administration rights.
o Groups
« Domain group statistics.
o Empty groups.
« Group hierarchy.
o Group list with member statistics.
« Organization Units (OUs)
« Member statistics by OU.
« OU hierarchy.
o« OU membership.
o Other Directory Objects.
« Active Directory object properties.
« All discontinued computer accounts.
o Computer accounts.
« Potential Issues

o Cycled groups.
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o Users

o Account Information

« Bad password information.

o Password age information.

o User account list.

User account options.

o Exchange 2000-2003 (or newer)

Email delivery options.
Email delivery restrictions.
Mailbox information by user.

Active Roles tracking log.

o Miscellaneous Information

Objects managed by a user.
Personnel hierarchy.
User profile information.

Users with specified properties.

o Obsolete Accounts

All discontinued user accounts.
Deprovisioned user accounts.
Disabled user accounts.
Expired user accounts.
Inactive user accounts.

Locked user accounts.

User accounts with expired password.

Active Roles Tracking Log

« Active Directory Management

« Deprovisioning of user accounts.

o Directory object management.

o User attribute management.

« Active Roles Configuration Changes

« Control delegation.

« Policy enforcement.

« Active Roles Events
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. Active Roles events statistics.

o Active Roles startup failures.
Active Roles Workflow

« Approvals and rejections.

« Workflow monitoring.
Dashboard

« User account management.

Administrative Roles

Access Template permissions.

Access Template summary.

Access Templates linked to Managed Units (MUs).
Access Templates linked to OUs.

Control delegation by object.

Control delegation by object (with group hierarchy).

Control delegation by trustee.

Control delegation by trustee (with container hierarchy).

Managed Units

MU members.

MU membership rules.

MU summary.

MUs affected by policies.
MUs with delegated control.

Policy Compliance

Objects violating policy rules.

Violated policy rules.

Policy Objects

(GNE IDENTITY

Linked property validation settings.

Linked property validation settings (with inheritance).
Linked script settings (with inheritance).

Policy Object references.

Policy Object settings.
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o Policy Object summary.
« Policy Objects with securable objects.

« Securable objects (with inheritance).
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Preparing the offline join of the
Active Roles On Demand server

Before sending the One Identity Active Roles On Demand configuration information
required by the One Identity Cloud Operations Team, you must prepare the Active Roles
server for an offline domain join by generating a domain join file. You will need upload this
file to the One Identity Starling portal (https://www.cloud.oneidentity.com) when sending
the required configuration information.

Prerequisites

You must use an account with Active Directory permissions to perform a domain join. By
default, Domain Admins have this permission.

To prepare the offline join of the Active Roles server

1. Determine the domain and Organizational Unit (OU) where the Active Roles server
will be deployed.

NOTE: Consider the following when planning the deployment of the Active
Roles server:

« If you have more than one domain and need assistance in determining the
proper Active Directory domain to use for this procedure, contact One
Identity Support.

« Do not pre-create the Active Roles server name, as this procedure will create
the computer object automatically in the specified OU.

2. Generate an offline domain join file for One Identity. To do so, open a
Command Prompt with elevated privileges on a Windows server joined to the
same domain where the Active Roles server will be deployed, and run the
following single-line command:

djoin /provision /domain <domain-name> /machine <activeroles-server-netbios-
name> /machineou "OU=<OU-name>,DC=<NetBIOS-domain-name>,DC=<domain-suffix>"
/savefile <X>:\<folder-name>\0DJBlob.txt
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"OU=AR-Test ,0U=Apps, DC=ar-od, DC=1ab"|

or\Desktop\0DIBlob. txt].

NOTE: Do not use a Container (CN) for the target location. Use only an OU

instead. If you still prefer to use the default Computers CN, remove the /machineou
switch and value.

3. Perform the steps of Sending required information to One Identity and upload the

generated 0DJBlob.txt file to the Technical Information form of the One Identity
Starling portal.

The One Identity Cloud Operations Team will use the attached 0DJBlob.txt file to complete

the offline domain join and deploy the Active Roles On Demand tenant for your
organization.

NOTE: Do not proceed to the Initial configuration of Active Roles On Demand process

until One Identity has confirmed that the Active Roles On Demand tenant is ready for
configuration.
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Sending required information to
One Identity

Before the One Identity Cloud Operations Team can configure and provision your Active
Roles On Demand environment, you must send a set of configuration information via the
One Identity Starling portal (https://www.cloud.oneidentity.com).

Prerequisites

Before collecting and sending the required information, make sure that the following
conditions are met:

« Your organization is already registered on the One Identity Starling portal.

« If you configure a product trial, your One Identity representative notified your
organization that the product trial has been added to your organization account.

« If you configure a subscribed product, your organization received a subscription
confirmation email from One Identity.

To send product configuration information to the One Identity Cloud
Operations Team

1. To open the list of product services available for your organization, in the One
Identity Starling portal, click Services.

{GMNE IDENTITY" Starling

One Identity Starling

Irity and extend to the
nce

My Services

Active Roles On
Demand

2. To start configuring the product, open the Application page of Active Roles
On Demand.
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« To configure a product trial, open the View On Demand services ribbon at
the bottom of the page and click Active Roles On Demand > Trial. This will
create the trial subscription for you. Continue configuring the trial subscription
as described in the next bullet point.

« To configure a subscribed product (or an active product trial), click My
Services > Active Roles On Demand.

3. Inthe Contact Information step, specify whether you are the technical contact for
the One Identity Cloud Operations Team in your organization.

Application  Collaborators

Configuration

See the status of the On Demand service and provide additional information for the deployment.

@ contactinformation @ rechnicat information © s:tineup

Contact Information

Contact information for the person who is responsible for the configuration and administration of the On Demand service.

| am the technical contact  Someone else is the technical contact

One Identity Operations will use the information that you provided during Starling registration.

Next: Technical Information

« If you are the technical contact (that is you have all the technical information
required by One Identity to configure and provision Active Roles On Demand),
select I am the technical contact and click Next: Technical information.

« If you are not the technical contact, then invite the contact who can provide the
required configuration information. This is typically required if the initial On
Demand invitation email was sent to you due to organizational policies, even if
you are not the technical contact of the On Demand product. To invite the
actual technical collaborator:

a. Select Someone else is the technical contact, then click Invite
Collaborator.

b. Inthe Invite Collaborator dialog, provide the name and email address
of the technical contact.

c. To send an invitation to the specified contact, click Invite.

TIP: You can also invite a technical contact by clicking Collaborators
on the top left corner of the One Identity Starling web interface.

Once you sent the invitation to the technical contact, make sure that they
perform the remaining steps.

4. Inthe Technical Information step, provide the required configuration information
as instructed on-screen. To upload the offline domain join file created previously as
described in Preparing the offline join of the Active Roles On Demand server, click
Active Directory Domain Join File > Upload Join File.

5. To confirm the information you entered, click Submit Details. This opens the
Confirm Details dialog, where you can either send the information to the One
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Identity Cloud Operations Team (Submit Details), or return to the Technical
Information step and make any final changes (Edit Details).

NOTE: Once you submit the specified information, you cannot make any further
changes, unless One Identity rejects the provided configuration information for
some reason.

6. Once you sent the configuration information, the Setting Up step will indicate the
status of provisioning and configuring Active Roles On Demand. One Identity will also
send you an email notification each time the status of deployment changes.

o Contact Information ° Technical Information o Setting Up

Waiting for One Identity

We are working on setting up your On Demand service. We will send you an update when it is a ready.

Waiting for an engineer to begin deployment  +
@ Deploymentin progress <

o Deployment Information

Deployment will take 4 hours

The Setting Up step will also indicate if configuration fails for any reason (for
example, because of incorrect data provided in the Technical Information step).

o Contact Information ° Technical Information o Setting Up

Waiting for One Identity
We are working on setting up your On Demand service. We will send you an update when it is ready.

Waiting for an engineer to begin deployment  +
@ Deploymentin progress X

€3 We could not finish the setup

Incorrect IP address provided in Technical Information.

Update Details

To open the Technical Information step and fix the provided information as
requested by the One Identity Cloud Team, click Update Details. Once you updated
the configuration details, resend them to the One Identity Cloud Operations Team by
clicking Submit Details again in the Technical Information step.

Once Active Roles On Demand is configured for your organization, the Application page of
Active Roles On Demand will display the connection and configuration data of your On
Demand deployment.
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Initial configuration of Active Roles
On Demand

When One Identity personnel confirmed to you that the offline join procedure of the
Active Roles server has finished, perform the initial configuration of One Identity Active
Roles On Demand.

Prerequisites

Make sure that the following conditions are met before performing initial configuration:

« One Identity confirmed that the Active Roles On Demand tenant is ready for
configuration.

« The Active Roles server deployed by One Identity personnel is joined to the Active
Directory of your organization.

. The Active Roles installation package is downloaded from the One Identity
Support Portal.

« The user account that you use for configuring the Active Roles components is a
Local Workstation Administrator, and has all required Active Directory permissions.
For more information, see Required Permissions and Access in the Active Roles
How-To Guide.

o The workstation where you perform the procedure meets the minimum system
requirements (described in Active Roles On Demand system requirements) and is
joined to the same domain as the Active Roles server.

« The Active Roles Service Account has the proper permissions. For more information,
see Required Permissions and Access in the Active Roles How-To Guide.

| NOTE: For each added domain, additional service accounts may be required.

« An Active Directory group containing the administrators of Active Roles (and the
account used to perform the following procedure) has been created.

« All required communication ports are open for any firewalls. For more information,
see Appendix C: Communication ports of the Active Roles Administration Guide.
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Installing the One Identity Certificate

To ensure that the Active Roles Configuration Center installed on-premises can
communicate with the Active Roles server deployed by One Identity, you must install the
One Identity certificate on the workstation(s) where the Active Roles Configuration Center
will be used.

NOTE: Perform this procedure only on the workstation(s) of the Active Roles admin-
istrator(s) who will run the Active Roles Configuration Center. You do not need to perform
this procedure for any other Active Roles users, interfaces or management tools.

The Active Roles Configuration Center can only connect to the Active Roles server
deployed by One Identity if this procedure is performed.

To install the One Identity Certificate

1. On an Active Roles administration workstation, navigate to the following UNC path:

\\<active-roles-server-name>\C$\Program Files\One Identity\Active
Roles\7.5.3\Shell

2. To open the list of Active Roles-specific signatures, right-click the
ActiveRolesServiceConfiguration.psml file and click Properties > Digital
Signatures.

3. To open the details of the certificate, on the Digital Signatures tab, select ONE
IDENTITY LLC from the Signature list and click Details.

General Digital Signatures  Securty Detals  Previous Versions

Signature list

MName of signer: Digest algorthm ~ Timestamp
ONE IDENTITY LLC sl ‘Wednesday, March 3.

Details

4. On the Digital Signature Details > General tab, click View Certificate.
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Digital Signature Details ? X

General  Advanced

—_, Digital Signature Information
This digital signature is OK.

Signer information

Name: |onE DENTTTY LLC

E-mail: INot available

Signing time: |Wednesday, March 31, 2021 10:25:22 AM

View Certificate

5. To launch the Certificate Import Wizard, on the Certificate > General tab, click
Install Certificate.

n  Certificate *

General Detals Certification Path

A Certificate Information

This certificate is intended for the following purpose(s):

* Ensures software came from software publisher
* Protects software from alteration after publication

*Refer to the certification authority’s statement for details.

Issued to: ONE IDENTITY LLC
Issued by: COMODQ RSA Code Signing CA

Valid from 6/10/2020 to &/11/2022

Install Certificate... | | Issuer Statement

6. Under Store Location, select Local Machine and click Next.
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£ Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections, A certificate store is the system area where certificates are kept.

Store Location
O Current User

{®) Local Machine

To continue, dick Mext.

7. Inthe Certificate Store step, select Place all certificates in the following
store and click Browse.

pot

€ £* Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windaws can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:
| Browse...

8. In the browse window that appears, select the Trusted Publishers directory
and click OK.

9. To apply your changes, close all remaining steps of the Certificate Import Wizard by
clicking Next, Finish and OK, respectively.
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First-time configuration of Active Roles
On Demand

When the One Identity Certificate is installed on the workstation(s) that will run the Active
Roles Configuration Center, perform the first-time configuration of One Identity Active
Roles On Demand.

To perform the first-time configuration of Active Roles On Demand

1. Copy the downloaded Active Roles .zip or .iso file to the local workstation of an
Active Roles administrator. Depending on the file format of the installer, extract the
.zip or mount the .iso.

2. To start the installation of the Active Roles Configuration Center, double-click the
Configuration Center installation package in the local extracted location or the
mounted ISO drive:

Components\ActiveRoles Configuration Center\ConfigCenter.msi

NOTE: The installation will progress without interaction, and will complete without
a completion prompt.

After the installation is complete, the Active Roles Configuration Center will
appear in the Windows Start Menu.

3. Open the Active Roles Configuration Center in the Windows Start menu.

In the Select Server window, select Another server, enter the name of the Active
Roles server in the Server field, and the connection credentials to the User name
and Password fields.

To proceed, click Connect. The Active Roles Configuration Center window will
then appear.

5. To open the server settings of Active Roles, click Configure under Dashboard >
Administration Service.
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10.

11.

@NE IDENTITY ‘ Active Roles

Dashboard

1 Logging
r. Administration Service
ﬁ Configure

The Configure Administration Service window then opens.

[ Configure Administration Service - [m] X

Configure Administration Service

> Service Account Service Account
i " i
Active Roles Admin Supply the logon name and password of the account in which the Active Roles
Configuration Database Options Administration Service will be running,
Configuration Database Connection Logon name: | ActiveRoles)_ar-adminsvc

MH Database Options

Password: sessssssses
MH Database Connection

Ready to Configure

Execution

In the Service Account tab, enter the Active Roles service account credentials in
the Logon name and Password fields.

In the Active Roles Admin tab, enter the domain group of the Active Roles
administrators.

In the Configuration Database Options tab, select the New Active Roles
database > Use a pre-created blank database option.

In the Configuration Database Connection tab, configure the following options:
. Database Type: Select Azure SQL Database.

. Database Server Name: Enter the server name provided by One
Identity personnel.

. Database Name: Enter the name of the Configuration database provided by
One Identity (ActiveRoles_CFG).

. Connect using: Select SQL Server authentication and enter the Azure SQL
login credentials provided by One Identity to the Login and Password fields.

In the Management History Database Options tab, select New Active Roles
database > Use a pre-created blank database.

In the Connection to Management History Database tab, configure the
following settings:

. Database Type: Select Azure SQL Database.

. Database Server Name: Enter the server name provided by One
Identity personnel.
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. Database Name: Enter the name of the Management History database
provided by One Identity (ActiveRoles_MH).

. Connect using: Select SQL Server authentication and enter the Azure SQL
login credentials provided by One Identity to the Login and Password fields.

12. (Optional) On the Encryption Key Backup tab, set up a password-protected backup
of the configuration. To specify the location of the backup file, click Browse. To
configure password-protection for the backup, select Protect the backup file with
a password and enter the password for the backup.
| NOTE: Keep a copy of this file and password in a secure location for future use.

13. On the Ready to Configure tab, review your settings. When you are ready to apply
the changes, click Configure.

The Configure Administration Service window will display the configuration
progress in the Execution (Progress) tab.

14. When the configuration finished:

« To close the Configure Administration Service window, click Finish.
« To open the configuration log, click the View log link.
TIP: Use the provided support links of this tab to access the video tutorials,
knowledge base articles and other support resources of Active Roles.

15. On the Active Roles Configuration Center, click Manage Settings under
Dashboard > Administration Service.

©NE IDENTITY | Active Roles
Dashboard

£ Administration Service
5 Logging Administration Service
o Starling QE .‘.'s"egeie’:mgs.
1 MMC Interface Access mport configuration

mport Management History
52 Solution Intelligence

16. Wait for the Administration Service to change from Getting ready to Ready for
use status. When this happens, open the Configure Web Interface window by
navigating to Dashboard > Web Interface > Configure.

@NE IDENTITY | Active Roles

Dashboard

¥ Administration Service

[% Logging r Administration Service p \VNebVInterface
P coomtn

17. Inthe Administration Service tab, select Administration Service on the
computer running the Web Interface and click Configure.
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[ Configure Web Interface - m] X

Configure Web Interface

Administration Service

frecution Specify how you want the Web Interface to select the Active Roles Administration Service.

Configure the Web Interface to select:
(® Administration Service on the computer running the Web Interface

(O Administration Service on this computer:

O Any Administration Service of the same configuration as this one:

The Configure Web Interface window will show the configuration progress in the
Execution (Progress) tab.

With the SSL certificates also installed, the first-time configuration of Active Roles On
Demand is finished, and it is ready to add and manage any Active Directory domains. Close
the Active Roles Configuration Center.

Installing the Active Roles Console

The Active Roles Console (also known as the MMC Interface) is a comprehensive
administrative tool for managing Active Directory and Microsoft Exchange objects. Using
the Console, Active Roles administrators can specify administrative roles and delegate
control, define administrative policies and automation scripts, easily find directory objects,
and perform various administrative tasks.

NOTE: The Active Roles Console can be installed and used by any Active Roles On
Demand user.

To install the Active Roles Console

1. Launch the installer package of the Console from the Active Roles source files. The
files are available at the following locations of the extracted Active Roles installer
(when using the .zip file) or the mounted .iso image:

o If you use a 32-bit operating system, run \Components\ActiveRoles
Console\x86\Console x86.msi
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« If you use a 64-bit operating system, run \Components\ActiveRoles
Console\x64\Console x64.msi

NOTE: The installation will progress without interaction, and will complete without
a completion prompt.

Upon completion, the Active Roles Console will be visible in the Windows Start Menu
as Active Roles 7.5.3 Console.

2. Start the Active Roles Console by clicking Active Roles 7.5.3 Console in the
Windows Start Menu, and wait until the Active Roles Console establishes a connection
to the Active Roles server and opens.

[ Active Roles *

Connecting to Administration Service on "WSTS8.ar742.lab"...
Loading schema...
Success

Please wait while the console establishes a connection.

[ [T

3. When Active Roles Console first opens, its Domains section will be blank. To
configure the first domain, see Adding the first domain to the Active Roles Console.

[ Active Roles Console — m]
[ File Action View Window Help - 8%
e @ olcEmeEhTaEE
W Active Roles [WST98.2r742.12b]
» @ Configuration
> & Active Directory
> & AD LDS (ADAM)
> £ Applications

052 Mangosd Qonsins

After adding the first domain, it will appear for all other users when they open the
Active Roles Console on any workstation or server.

Installing the Active Roles
Management Shell
The Active Roles Management Shell component allows you to manage and configure Active

Directory and Active Roles objects, Active Roles Administration Service instances, or Web
Interface sites via PowerShell scripting.
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NOTE: The Active Roles Management Shell can be installed and used by any Active Roles
On Demand user.

To install the Active Roles Management Shell

1. Launch the installer package of the Management Shell from the Active Roles source
files. The files are available at the following locations of the extracted Active Roles
installer (when using the .zip file) or the mounted .iso image:

o If you use a 32-bit operating system, run \Components\ActiveRoles Management
Shell\x86\Shell x86.msi

o If you use a 64-bit operating system, run \Components\ActiveRoles Management
Shell\x64\Shell x64.msi

NOTE: The installation will progress without interaction, and will complete without
a completion prompt.

Upon completion, the Active Roles Management Shell will appear in the Windows
Start Menu as Active Roles 7.5.3 Management Shell.

2. To verify that the Management Shell has been installed properly, launch it by clicking
Active Roles 7.5.3 Management Shell in the Windows Start Menu.

The Management Shell interface will appear.

E Active Roles Management Shell [WEC]

Welcome to Active Roles Management Shell

Full list of cmdlets Get-Command
Only Active Ro ets: Get-ARCommand

Show reference guide: QuickRef

Get general help Help

Get help for a cmdlet: Help <cmdlet name> or <cmdlet name> -?
Community: Get-ARCommunity

Adding the first domain to the Active
Roles Console

After installing the Active Roles Console (also known as the MMC Interface) as described
in Installing the Active Roles Console, you must add a new domain to Active Roles On
Demand with it.

To add a Domain to Active Roles On Demand

1. On a workstation where the Active Roles Console is installed, launch the Console
from the Windows Start Menu by navigating to One Identity Active Roles 7.5.3 >
Active Roles 7.5.3 Console.

The Console will automatically find the Active Roles server and connect.
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U Active Roles

Connecting to Administration Service on 'WST98.ar742.1ab’...
Loading schema...
Success

Please wait while the console establishes a connection.

e e e e e = D
2. To open the Add Managed Domain Wizard, click Add Domain in the middle pane,
then click Next.

U Active Roles Console

[ File Action View Window Help

e @ olcBE LTS D
ﬁ" Active Roles [AR742B.ar742.1ab]
> ﬁ Configuration

> @ Active Directory

> @& AD LDS (ADAM)

> ﬂ Applications

A/ Domains

Add Domain...

3. In the Domain Selection step, either enter the name of the Active Directory
domain you want to manage in Active Roles into the Domain name field, or click
Browse to select it.

Add Managed Domain Wizard

Domain Selection

You can spedfy what domain you want to manage with Active Roles. E

Type the name of the domain or click Browse to select the domain.
Domain name: [ |

In the Active Roles Credentials step, select the default service account Active
Roles was configured with.

(GNE IDENTITY
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Add Managed Domain Wizard ? x
Active Roles Credentials |
Spedify credentials that Active Roles will use to access the domain. -

Access the domain using:
(®) The service accountinformation the Administration Service uses to log on

Each Administration Service in your environment will use its own service account to
access the domain. As a result, the behavior of Active Roles may vary when you
switch to a different Service.

() The Windows user account information spacified below

o For typical use cases, select The service account information the
Administration Service uses to log on.

« If the domain to add is not in the same domain as the Active Roles server, or
you must use a different account because of any technical or administrative
reason, select The Windows user account information specified below,
and provide the service account credentials.

Review your changes, then to apply the domain configuration, click Finish.

6. The configured domain then appears grayed out on the Active Roles Console while it
loads information into Active Roles. To refresh the loading status, click Click to
update the display.

When this one-time loading operation finished, the Domain information is being
loaded state will change to Available for management, and the Active Directory
domain will appear in the Active Roles Console on the left pane under the Active
Roles > Active Directory node.

Validating the Active Roles Web
Interfaces

When you specified a new domain as described in Adding the first domain to the Active
Roles Console, confirm that each Active Roles web interface (that is the Administrator Site,
the Help Desk Site and the Self-Service Site) opens and works properly.

To validate the Active Roles Web Interfaces

On any workstation, open each of the following web sites in a supported browser to confirm
they are working properly:

o Administrator Site: http://<activeroles-fqgdn-servername>/ARWebAdmin
« Help Desk Site: http://<activeroles-fqgdn-servername>/ARWebHelpDesk

NOTE: The home page level of the Help Desk Site looks the same as the Admin-
istrator Site.

« Self-Service Site: http://<activeroles-fqdn-servername>/ARWebSelfService
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When prompted for credentials for any of the interfaces, use your Active Directory
credentials.

Installing the Active Roles Collector and
Report Pack

Optionally, if you require Active Roles reporting capabilities, install the Active Roles
Collector and Report pack. For more information on the available reports, see Available
Active Roles Reports.

NOTE: Although this component must be installed on-premises, the reporting database
itself is hosted in the Active Roles SaaS tenant in Azure SQL. Therefore, no on-premises
database sizing is required.

Prerequisites

Make sure that the following conditions are met before installing the Active Roles Collector
and Report Pack:

« The SQL server and SQL Server Reporting Services are installed, configured, and
confirmed to be running on premises.

TIP: One Identity recommends the Reporting Services web portals use SSL
certificates.

. Aserver is available to:
« Install the Active Roles Collector and Report Pack component.

« Host a Windows Scheduled Task that will gather data about Active Roles and
Active Directory populating the reports.

This server will act as the on-premises Active Roles Reporting Server, and will be
referred to as such in later parts of the configuration procedure.

« The following PowerShell modules are available:
« Exchange Online PowerShell v2 module x64
| NOTE: Use version v2.0.3 of the module.
To install the module, enter the following command:
Install-Module -Name ExchangeOnlineManagement -RequiredVersion 2.0.3
o Azure AD Module
To install the module, enter the following command:
Install-Module -Name AzureAD
« Microsoft Azure Az Module

To install the module, enter the following command:
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Install-Module -Name Az

« Microsoft Teams cmdlets module
To install the module, enter the following command:
Install-Module MicrosoftTeams

o (Optional) SharePoint Online Management Shell (x64 version)
To install the module, enter the following command:
Install-Module -Name Microsoft.Online.SharePoint.PowerShell

« A dedicated Active Roles Reporting domain service account is available.

NOTE: When using a dedicated Active Roles Reporting domain service account, you
must explicitly grant Log on as a batch job user rights assignment on the Active
Roles Reporting Server, as indirect membership will not work.

To grant Log on as a batch job user rights assignment for the Active
Roles domain service account

1. On the Active Roles Reporting Server, right-click the Windows Start menu
and click Run.

2. Type gpedit.msc and click OK.

Navigate to Computer Configuration > Windows Settings > Security
Settings > Local Policies > User Rights Assignment.

4. Double-click Log on as a batch job and add the Active Roles Reporting
domain service account.

5. To refresh the policy change and have it take effect immediately, open a
Command Prompt and type gpupdate /force.

« The Active Roles Reporting domain service account must be a member of:

« The Active Roles Administrators group, so that it can read all Active Roles
configuration data. For more information on configuring the Active Roles
Administrators group, see First-time configuration of Active Roles On Demand

« (Optional) The local Event Log Readers group of the Active Roles Reporting
Server to read all event logs from the Active Roles Admin Service event
log. However, leveraging a Log Management or SIEM solution may be
preferred instead.

To install the Active Roles Collector and Report pack

1. On the Active Directory Reporting Server, in the root folder of the extracted Active
Roles installer (when using the .zip file) or the mounted .iso image, right-click
ActiveRoles.exe and run it as an administrator.

2. On the Introduction screen, select the Due to the new features... check box, and
review the linked license requirements. When you are ready, click Next.

3. Inthe License Terms step, select I accept the terms in the license
agreement and click Next.
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4. Inthe Component Selection step, select only Management Tools from the list,
and specify the installation folder path.

Active Roles @)NE IDENTITY

Component Selection

Select the Active Roles components to install on this computer.

1 of 5 components selected 25 ME required
[ Administration Service b4
[C] Web Interface A
[0 Console (MMC Interface) A4
Management Tools v
|:| Synchronization Service v
Path to installation folder
Ci\Program Files\One Identity\Active Roles\ m

5. Inthe Ready to Install step, verify that only the Management Tools are selected
and click Install.

NOTE: The Install button may be grayed out if any prerequisite software is
missing at this point. All missing software are listed and linked in this step.

Active Roles @)N EIDENTITY

Ready to Insta

Review the installation settings you have specified.

Before you install Active Roles, download and install the following prerequisite software

SharePoint Online Management Shell - x64 Version (Optiona

Azure AD Module.

Azure Az Module,

Microsoft Teams
Active Roles components to install
Management Tools

Click Install to perform Active Roles installation.
Installation folder: C:\Program Files\One Identity\Active Roles\

To finish the installation of the Active Roles Management Tools, install all
listed prerequisite software, click Back, then Next, and finally Install, when
it is enabled.

6. The installation will begin. Monitor the progress on the Setup Progress page. When
installation is ready, on the Completion page, click Finish
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7. From the Active Roles source files of the extracted Active Roles installer (when using
the .zip file) or the mounted .iso image, run the \Solutions\Collector and Report
Pack\ActiveRolesCollectorAndReports_7.5.3.msi package.

8. On the introduction screen, click Next.
In the License Terms step, accept the license terms and click Next.

10. Inthe Installation Folder step, enter the path where you want to install Active
Roles Collector and Report Pack.

11. In the Ready to Install step, click Install, then click Finish when
installation completed.

Configuring the Active Roles Collector
and Report Pack

If you have optionally installed the Active Roles Collector and Report Pack as described in
Installing the Active Roles Collector and Report Pack, you must configure it to use its data
collection and reporting features.

To configure the Active Roles Collector and Report Pack

1. From the Windows Start Menu, launch One Identity Active Roles 7.5.3 > Active
Roles 7.5.3 Collector and Report Pack.

In the Select Task step, select Collect data from the network and click Next.

In the Configure Connection step, to specify a new data collection database, click
Specify next to the Database field.

Active Roles @)N E IDENTITY

Configure Connection

Specify a database to store collected data, computer running Active Roles Administration Service, and logon credentials.

4. In the Specify Database step, select Create Database and configure the
following settings.
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(2 specify Database - ] X

Collector can create a new database or use an existing database of the current version.
(® Create database
(O Use existing database

Database type: | Azure SQL Database i
SQL Server: ProvidedAzureSQLServer.database.windows.net

Database: ActiveRoles_Collector

Connect using

(O Azure Active Directory authentication
(®) SOL Server authentication

Login: €1000

Password: .II..U.....*

. Database Type: Select Azure SQL Database.

« SQL Server: Enter the name of the Azure SQL server provided by One
Identity.

. Database: Enter ActiveRoles_Collector.

« Connect using: Select SQL Server authentication and enter the Azure SQL
login credentials provided by One Identity to the Login and Password fields.

To continue configuration, click OK. The database will be created in the Azure SQL
instance of your Active Roles SaaS tenant. When the database is created, the
Database field of the Configure Connection step will be automatically populated.

5. Inthe Configure Connection step, specify the Active Roles Service server name in
the Active Roles Service field, then select Log on as > Specified user and
provide the login details of the Active Roles Reporting domain service account
credentials created as a prerequisite for Installing the Active Roles Collector and
Report Pack.
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Active Roles @)NE IDENTITY

Configure Connection

Specify a database to store collected data, computer running Active Reles Administration Service, and logon credentials.

Database: ActiveRoles_Collector on arod-asql.database.windows.net

Active Roles Service: | service.activeroles.org
Log on as
O Current user
@® Specified user
User name: | ActiveRoles‘\_ar-reporting

Password: essssssssse

6. Inthe Data Collection Tasks step, select Active Directory and Policy
Compliance Information as the type of data that the Active Roles Collector and
Report Pack will collect.

Active Roles @)N E IDENTITY

Data Collection Tasks
Select the data collection tasks you want to perform
Active Directory

Collect information about users, groups, computers, organizatienal units, and domains from Active Directory.

Policy Compliance Information

Collect data to determine whether directory objects comply with the policies defined by Active Roles. Note that this option
requires the Active Directory option to be selected

[C] Active Roles event log

Collect events from the Active Roles event log on the computers running Active Roles Administration Service.

TIP: You can also select Active Roles event log to collect application event logs
with the Active Roles Collector and Report Pack. However, One Identity recom-
mends to use a dedicated Log Management or SIEM solution to gather and archive
event logs.

7. Inthe Data to Collect step, select all categories except Access Templates, and
click Next.

NOTE: Selecting all check boxes (including Access Templates) in this step will
result in a data collection error as described in Knowledge Base Article 230239 in
the One Identity Support Portal.

This error occurs when configuring either an immediate or a scheduled data collec-
tion operation (configured with the Now and On a schedule settings of the Select
Operation Mode step, respectively). When running an immediate data collection
operation, this error is visible on the user interface. When performing a scheduled
run, the error is logged only in the collector log file at the following location:
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C:\ProgramData\One Identity\Active Roles\Logs\Collector\Collector-Active
Roles Collector (<task-name>)-<timestamp>.log

8. Inthe Select Domains or OUs step, to specify a new domain with the Browse for
Container dialog, click Add.

9. Inthe Browse for Container dialog, select the domain to use and click OK.
NOTE: If the domain to select is missing in this dialog, check the following:
o Make sure that Use subtree search is selected.

« Make sure that a domain has already been added to Active Roles as
described in Adding the first domain to the Active Roles Console. If no
domain has been previously added, this dialog will be empty.

The selected domain will appear in the Select Domains or OUs step.

10. Inthe Select Operation Mode step, under Run Active Roles Collector, select
On a schedule and name the mode (for example: Daily Collection).

Active Roles @)N EIDENTITY

Select Operation Mode

Select whether to perform the task immediately or to schedule it for a convenient time, and specify whether to disable SID resolving.

Run Active Roles Collector

O Now

(@ On a schedule
Marne: Daily Collection

Description:

11. Inthe Schedule step, to specify a new data collection schedule, click Add.

12. Inthe Configure Schedule dialog, configure the schedule with the available
settings and click OK.

TIP: One Identity recommends configuring a daily schedule that runs data collec-
tion in off-peak hours to minimize potential performance issues.

13. When the schedule is configured, it must appear in the Schedule step.
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Active Roles @)N EIDENTITY

Schedule

Click Change to set the time and day you want the task to start. Click Account to specify the user account under which the task will
run.

Type Start Time Start Date Details
Run on a daily basis 1:00 AM 4/30/2021 Recur every 1 days
e o e

User account under which the task will run
User name: | ActiveRoles\_ar-reporting

Password: essssssssss

m m Cancel

Under User account under which the task will run, specify the Active Roles
Reporting domain service account credentials.

14. To close the Active Roles Collector and Report Pack setup, click Finish.

NOTE: The log file of the configured logging operation is stored at the following
location by default:

C:\ProgramData\One Identity\Active Roles\Logs\Collector\Collector-<date>-
<time>.log

The ProgramData folder of the operating system is hidden by default.

15. Confirm that the configured collection task is listed in the Windows Task Scheduler.
Right-click the Windows Start Menu, and navigate to Computer Management >
System Tools > Task Scheduler > Task Scheduler Library. In this example,
the task is named Active Roles Collector (Daily Collection).

A Computer Management
File Action View Help
* = | zF|
;gl Computer Management (Local)
~ [["5 System Tools

Y ® Task Scheduler
_}9 Task Scheduler Library
[ R

MName

[&] Active Roles Collector (Daily Collection)
(® MicrosoftEdgeUpdateTaskMachineCore
B Mirrne nfHEdnzl IndataTackharhinel 10

16. To perform the first data collection run, right-click the Active Roles Collector
(Daily Collection) task and select Run.

17. When the task completed successfully, configure Active Roles Collector and Report
Pack so that it deploys reports to a report server. Open Active Roles Collector
and Report Pack again, and in the Select Task step, select Deploy reports to
Report Server.
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Select Task
Select the task you want to perform.

(O Collect data from the network

Collect data and events from computers running Active Roles Administration Service, and store the collected information in a
SQL Server database to make the information available for reporting.

(O Process gathered events
Export collected events to another SQL Server database, or delete obsolete events from the database.

() Import events from an earlier database version

As Report Pack is only compatible with the current database version, you need to import events from the database of an earlier
version to the database of the current version if you want to use those events for reporting.

(e) Deploy reports to Report Server
Publish the reports from Active Roles Report Pack to your SQL Server Reporting Services (SSRS) Report Server.

18. Inthe Report Server step, specify the Report Server Web Service URL.

Report Server

Supply the address of the Report Server to which you want to publish the Active Roles reports.

Report Server Web Service URL: | https://example.activeroles.url/Reportserver

If secure communication protocol (S5L) is enabled on Report Server, use https:// in Report Server
Web Service URL.

NS kN

TIP: By default, Active Roles Collector and Report Pack may populate the Report
Server Web Service URL field with an https:// scheme. Using this scheme if
you do not have a valid certificate and SSL enabled for SQL Server Reporting
Services will result in a Verification Failed error when Active Roles Collector and
Report Pack attempts accessing the Report Web Server service.

To avoid this error, change https:// to http:// in the URL in such cases.
19. In the Data Source step, click Configure Data Source.

20. Inthe Configure Data Source dialog, configure the following settings:

Database type: | Azure SQL Database -
SOL Server: ProvidedAzureSQLServer.database windows.net
Database: ActiveRoles_Collector

Connect using
(O Azure Active Directory authentication

(® SQL Server authentication
Login: C1000

Password: 'l..'ll.llq
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. Database Type: Select Azure SQL Database.

« SQL Server: Enter the name of the Azure SQL server provided by One
Identity.

. Database: Enter ActiveRoles_Collector.

. Connect using: Select SQL Server authentication and enter the Azure SQL
login credentials provided by One Identity to the Login and Password fields.

When ready, click OK to return to the Data Source step. The Database field will
display the configured data source.

21. Active Roles Collector and Report Pack will then start publishing the report
definitions. Use the progress bar to check the publish status. When the process
is completed:

« To close the Active Roles Collector and Report Pack, click Finish.
« To check the log of the procedure, click View log.

NOTE: The log file of the configured logging operation is stored at the following
location by default:

C:\ProgramData\One Identity\Active Roles\Logs\Collector\Collector-<date>-
<time>.log

The ProgramData folder of the operating system is hidden by default.

22. To validate whether Active Roles is present in the domain and that reporting works as
configured, open the SQL Reporting Services web portal with the /Reports path of
your Active Roles server (http://<FQDN-of-server>/Reports). Navigate to Active
Roles > 7.5.3 > Active Directory Assessment > Domains > Domain
Summary, and verify that the page is populated with data reports.

NOTE: Starting from Active Roles 7.4.4, Internet Explorer is no longer supported by
the Active Roles Web Interface. Therefore, One Identity recommends using one of
the following supported browsers when using any web-based Active Roles 7.5.3
interfaces:

« Mozilla Firefox 36 (or newer)

o Google Chrome 61 (or newer)

« Microsoft Edge 79 (or newer), based on Chromium

23. To open the settings of the SQL Reporting Services web portal, click & > Site
Settings at the top right corner of the page.

24. To assign administrator privileges to the Active Roles administrators (configured in
First-time configuration of Active Roles On Demand) for the configured Active Roles
report, navigate to Security > Add group or user.

25. Inthe Group or user field, enter the name of the Active Roles Administrators AD
group (for example, ARAdmins). Under Role, select the System Administrator role.
To close the dialog, click OK.
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Group or user: ARAdmins

Select one or more roles to assign to the

[] Rolen

System Administrator

[:l System User

o

26. Inthe SQL Reporting Services web portal, confirm that the configured administrator
group is now listed as System Administrator.

TIP: Even if the Configure Data Source > Database type option of the Active Roles
Collector and Report Pack is set to Azure SQL Database, the SQL Reporting Services
portal will identify it as Microsoft SQL Server.

This has no impact on the data collection operation, but you can still change the server
type designation with the following steps:

1. On the SQL Reporting Services web interface, navigate to Active Roles > Shared
Data Sources > Manage Active Roles 7.5.3 Report Data > Properties.

2. Under Connection, change the Type from Microsoft SQL Server to Microsoft
Azure SQL Database.

Adding the Reporting Link to the Active
Roles Console

When the Active Roles Collector and Report Pack is installed and configured, add the
reporting link to the Active Roles Console (also known as the MMC Interface).

To add the reporting link to the Active Roles Console

1. On a workstation where the Active Roles Console is installed, launch the Console
from the Windows Start Menu by navigating to One Identity Active Roles 7.5.3 >
Active Roles 7.5.3 Console.

2. In the left pane of the Active Roles Console, navigate to Applications > Reporting,
and click To view reports, specify report manager address.
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 Active Roles
> @ Configurstion  |[Generalfor Repottng (pplcation)
> @ Active Directory
> & AD LDS (ADAM)
v ﬂ Applications
Reporting Use a rich suite of reports for change tracking audits, corporate policy monitoring, and

Reporting

Click to open report manager where you can select, generate and preview reports.

0 To view reports, specify report manager address.

3. In the Report Manager Address dialog, enter the URL of the Active Roles
Reports resource:

http://<activeroles-server-name>.<domain-
name>.com/Reports/browse/Active%20Roles/7.5.3

4. To apply your changes, click OK.

The Applications > Reporting > View Reports button becomes enabled, allowing you to
access the Active Roles reports from the Active Roles Console.

Installing Active Roles Synchronization
Service

Optionally, you can install the Active Roles Synchronization Service component to
automate identity data synchronization between the data systems used in your
organization.

NOTE: If you plan to manage Azure AD or Office 365 operations in your environment, you
must install the Active Roles Synchronization Service component.

Prerequisites

Before installing Active Roles Synchronization Service, make sure that the following
hardware and software resources are available:

« Aninstalled, configured and functional on-premises SQL server.

« An on-premises server to host Active Roles Synchronization Service. This can be the
same server that hosts the on-premises Active Roles Reporting components
(described in Installing the Active Roles Collector and Report Pack).

« The following PowerShell modules are available:
« Exchange Online PowerShell v2 module x64
| NOTE: Use version v2.0.3 of the module.
To install the module, enter the following command:

Install-Module -Name ExchangeOnlineManagement -RequiredVersion 2.0.3
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https://www.powershellgallery.com/packages/ExchangeOnlineManagement/

o Azure AD Module
To install the module, enter the following command:
Install-Module -Name AzureAD

o Microsoft Azure Az Module
To install the module, enter the following command:
Install-Module -Name Az

« Microsoft Teams cmdlets module
To install the module, enter the following command:
Install-Module MicrosoftTeams

o (Optional) SharePoint Online Management Shell (x64 version)
To install the module, enter the following command:
Install-Module -Name Microsoft.Online.SharePoint.PowerShell

.NET Framework 4.7.2 or newer.

A domain service account with the required permissions. For more information, see
Active Roles KB Article 71413 on the One Identity Support Portal.

To install Active Roles Synchronization Service

1. On the on-premises server that will host the Active Roles Synchronization Service

component, navigate to and launch the Synchronization Service installer package.
The file is available at the following location of the extracted Active Roles installer
(when using the .zip file) or the mounted .iso image:

\Components\ActiveRoles Synchronization Service\SyncService.msi

NOTE: The installation will progress without interaction, and will complete without
a completion prompt.

2. To launch the Synchronization Service Configuration Wizard, in the Windows Start
Menu, click Active Roles 7.5.3 Synchronization Service.
3. Inthe Service Account and Mode step of the Configuration Wizard, configure
the following settings:
Configuration Wizard
Service Account and Mode
Enter the account under which you want Synchronization Service to run and specify whether you want to use this Synchronization Service in the local or remote mode.
Synchronization Service account
User name: ActiveRoles\ar-syncservice
Password: | sssssssssss
Synchronization Service mode
@ Local
O Remote
[ e |
@NE |DENT|TY Active Roles On Demand Quick Start Guide 45

by Quest


https://www.powershellgallery.com/packages/AzureAD/
https://www.powershellgallery.com/packages/Az/
https://www.powershellgallery.com/packages/MicrosoftTeams/
https://docs.microsoft.com/en-us/powershell/sharepoint/sharepoint-online/connect-sharepoint-online?view=sharepoint-ps
https://support.oneidentity.com/active-roles/kb/71413/permissions-required-by-the-synchronization-service-or-quick-connect-service-account

. Synchronization Service account: Enter the domain service account
credentials to use the Synchronization Service component (for example,
ActiveRoles\ar-syncservice).

« Synchronization Service mode: Select Local.

4. Inthe Instance Configuration step, select Create a new configuration and
click Next.

5. Inthe Database Connection step, configure the following settings:

Configuration Wizard

Database Connection

Specify SQL Server and databases where you want Synchronization Service to store its data.
SQL Serven ProvidedAzureSQLServer.database windows.net
Database: ActiveRoles_SyncSveCg

Store sync data in a separate database

Synchronization database: | ActiveRoles_SyncSvcData

Q Use Windows authentication

@ Use SQL Server authentication

Login: €1000

Password: sssssssssss |

s

o SQL Server: Enter the name of the on-premises Azure SQL server.
. Database: Enter ActiveRoles_SyncSvcCfg as the database name.

NOTE: Make sure that you enter the database name exactly as
specified above.

6. Select Store sync data in separate database, and under Synchronization
database, enter ActiveRoles_SyncSvcCfg.

| NOTE: Make sure that you enter the database name exactly as specified above.

7. Select the authentication method (Use Windows authentication or Use SQL
Server authentication) preferred to access the on-premises Azure SQL server.

8. (Optional) In the Configuration File step, set up a password-protected backup of
the configuration.

Configuration Wizard

Configuration File

Specify a il o save the Synchrorization Senvice configuration profile you created in this wizard,
Configuration file: Ci\Configurations\SyncServiceConfig.cfg m

Protect the file with the following password: | ssssssssss o ‘

Make sure you keep this file in a safe place. You will need to provide this file if you want another Synchronization Service instance to use the same configuration settings.

To specify the location of the configuration file, click Browse. To configure
password-protection for the backup, check Protect the file with the following
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password and enter the password for the file. To complete the configuration, click
Finish.

| NOTE: Keep a copy of this file and password in a secure location for future use.

Active Roles then starts the configuration of Synchronization Service. Upon successful
completion, the Synchronization Service component will open and will be ready to use.

TIP: For more information about configuring Active Roles Synchronization Service for
specific connectors, such as Azure AD or Microsoft 365, see the Active Roles Synchron-
ization Service Administration Guide.
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About us

One Identity solutions eliminate the complexities and time-consuming processes often
required to govern identities, manage privileged accounts and control access. Our solutions

enhance business agility while addressing your IAM challenges with on-premises, cloud and
hybrid environments.
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Contacting us

For sales and other inquiries, such as licensing, support, and renewals, visit
https://www.oneidentity.com/company/contact-us.aspx.
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Technical support resources

Technical support is available to One Identity customers with a valid maintenance contract
and customers who have trial versions. You can access the Support Portal at
https://support.oneidentity.com/.

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

Submit and manage a Service Request

View Knowledge Base articles

Sign up for product notifications

Download software and technical documentation

View how-to videos at www.YouTube.com/Oneldentity
Engage in community discussions

Chat with support engineers online

View services to assist you with your product
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